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ETABS v21.0.1 Release Notes
© 2023 Computers and Structures, Inc.

Notice Date: 10-May-2023

This document lists changes made to ETABS since v21.0.0, released 05-April-2023. Items marked with
an asterisk (*) in the first column are more significant.

Installation and Licensing
Enhancements Implemented
* Ticket Description
* 9646 The version number has been changed to 21.0.1 for a new minor release.
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Analysis
Incidents Resolved
* Ticket Description

9606 An incident was resolved where toolbar buttons & menu items related to analysis results
intermittently got disabled after an otherwise successful run. Only models with frame
elements where the frame design procedure had been overwritten and a design performed
experienced this behavior. This only affects recently released ETABS v21.0.0, earlier versions
did not have this issue.
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ETABS v21.0.0 Release Notes
© 2023 Computers and Structures, Inc.

Notice Date: 05-April-2023

This document lists changes made to ETABS since v20.3.0, released 22-July-2022. Items marked with an
asterisk (*) in the first column are more significant.

Analysis
Enhancements Implemented
* Ticket Description

8888 A change has been made to the Analysis Log form that can be displayed when the analysis is
running: (1.) When displayed, the Analysis Log form will always remain in front of the main
graphical user interface, and (2.) When the main graphical user interface is
minimized/restored, the Analysis Log form is also minimized/restored with it.

9056 The following enhancements have been made to the analysis messages, as shown in the
Analysis .LOG file, the Analysis Messages form, and the table "Analysis Messages": (1.) The
affected element type and element name are now given whenever applicable. (2.) The
Windows system error message text is now given for file IO errors. (3.) The “Results deleted”
informational messages are no longer shown for either user-initiated or internal operations
that would cause the results of a load case to be deleted. These messages were correct, but
sometimes caused confusion, when load cases were automatically re-run due to an iterative
process like finding the structural period to use for auto-wind or auto-seismic load cases.

9117 The cracked section analysis options have been expanded to include two options for the
convergence check: (1.) SRSS of Vertical Displacements, which is the same as the
convergence check used in ETABS v20, and (2.) Max Absolute Vertical Displacement, a newly
added option. The Max Absolute Vertical Displacement can be used for single-story models
where the deformation is primarily concentrated in the objects that have cracked-section
properties and the user is only interested in the maximum deflection. The SRSS convergence
check option is more appropriate for larger models with cracking occurring on multiple
stories. These changes only affect cracked section analysis, which is available for Nonlinear
Static and Staged Constructions load case (Define menu > Load Cases).

9215 The Analysis Monitor form has been enhanced for running load cases in parallel so the now
the Summary tab displays the Run Tag and the Status of completed load cases (e.g.,
“Finished”, “Not Finished”, “Could not Start”, etc.), making it possible to easily identify load
cases that didn’t complete while the analysis is still running or after it is done.

API
Enhancements Implemented
* Ticket Description

8694 A new page has been added to the API documentation with guidance on how to create a
client application using .NET 6. It can be found in the "Key Concepts" folder of the
documentation.

8847 An enhancement has been made to the Application Programming Interface to add new
functions cAutoSeismic.GetASCE716 and cAutoSeismic.SetASCE716 for the ASCE 7-16 auto-
seismic loading.

9022 An enhancement was implemented for the Application Programming Interface (API) to add
or update several functions for the cPropFrame interface: GetChannel_1, SetChannel_1,
GetColdC, SetColdC, GetColdC_1, SetColdC_1, GetColdHat, SetColdHat, GetColdHat_1,
SetColdHat_1, GetColdZ, SetColdZ, GetColdZ_1, SetColdZ_1, GetConcreteBox,
SetConcreteBox, GetConcreteCross, SetConcreteCross, GetConcretePipe, SetConcretePipe,
GetDblAngle_1, SetDblAngle_1, GetPrecastI, SetPrecastI, GetTube_1, and SetTube_1.
Functions with "_1" include mirroring parameters that are only applicable to ETABS, and
they will return a "Not Implemented" code if called from a product other than ETABS when
using the cross-product API.
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* Ticket Description
9233 A new API example for the IronPython programming language has been added to the CSI API

ETABS v1.chm file. In addition, the Python (COM) and Python (.NET) examples have been
updated to work with the latest versions of Python and their required packages.

9433 An enhancement has been made to the Application Programming Interface (API) to add the
function AssembledJointMass_1 to replace deprecated function AssembledJointMass. The
new function adds the named mass source as an input argument. The previous function did
not have this argument and would return the assembled joint mass corresponding to the
first defined mass source. For most models, where there is only one mass source, this was
not an issue. In addition, the function AssembledJointMass would return zero mass values
unless at least one load case or combination was selected by using the function
SetCaseSelectedForOutput. This is no longer the case for either function. However, at least
one load case using the specified mass source must be run in order to return mass values.
Otherwise, zero values will be returned.

Data Files
Enhancements Implemented
* Ticket Description

9338 Minor corrections have been made to the Chinese frame-section database file
ChineseGB08.xml. These include (1.) Changing section name YB-WH700X300X12X38 to YB-
WH700X300X12X28, with the corresponding change in flange thickness, and (2.) Minor
changes to the section moduli of several sections. No section property values affecting
analysis were changed, and the effect on design properties is insignificant. These changes
only affect models that import these properties from the new database file. Models that
imported properties from an earlier database file will not be affected.

Database Tables
Enhancements Implemented
* Ticket Description

8784 An enhancement has been implemented to segregate the materials per New Zealand and
Australian standards into three separate XML library files: Australia, New Zealand, and
AustraliaNewZealandCommon. New concrete materials as per AS 3600:2018 V2 standard
have also been added to Australian material library under this enhancement. Previously, the
materials from Australian and New Zealand standards were included together in the single
materials library for the New Zealand region. When a new model is created, the option to
select the "Australia" region for default materials is now available in addition to the New
Zealand region. When adding new materials, any of the three libraries can be accessed.

8915 An enhancement has been implemented that provides an option to generate tabular output
only for items used in the model. This option applies to display tables, reports, and export of
model data in any of the available formats. The implementation mainly covers items under
the Define menu that are not assigned to any objects in the model.

9005 An enhancement has been implemented to show the definition of plot functions in tabular
format (MODEL DEFINITION > Other Definitions > Plot Function Data). Previously, this
information was only accessible through Define > Plot Functions menu after the analysis had
been run. The plot function definitions can now also be interactively edited with the model
in unlocked or locked state.

9012 An enhancement has been implemented to (1.) Allow users to interactively edit
performance-check definitions even when the model is locked. Previously, performance
check definitions could only be edited interactively when the model was in unlocked state.
(2.) Allow users to select the desired performance check data sets for associated tabular
output. The data sets can be selected on the database table form either by clicking on the
"Edit > Set Output Selections" menu or by clicking on the "Set Output Selections" button.
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* Ticket Description
9168 An enhancement was made for the interactive database editing of the Design Overwrites

table for the SP 63.13330.2012 concrete frame design in which the parameters "Consider
Crack Analysis?," "Crack Width Limit Full Load, a_crc, ult(mm)," "Crack Width Limit Long
Term, a_crc,l,ult(mm)," "Longitudinal Rebar Size Top," "Longitudinal Rebar Size Bottom,"
and "Longitudinal Rebar Ribbed?" have now been included.

9173 An enhancement was made to now include all selected load cases for tables "Diaphragm
Max Over Avg Drifts" and "Story Drifts" when using Chinese licenses. Previously, only lateral
load cases were reported for Chinese licenses. The behavior is now identical in all license
types.

9202 An enhancement has been implemented to include the program name, program version,
and the version for each table in the export of table and field keys to the XML file from
within the software. Additionally, the menu command for this export has been changed to
"Options > Database > Write Table and Field Keys to XML File" to better reflect the
information being exported. Previously, the command was "Options > Database > Write
Table and Field Names to XML File...". The resulting XML file as applied to all possible tables
is now automatically included in the installation folder. This can be compared between
versions of the software to see which tables have been changed. This information can be
used to update programs and scripts that work with exported/imported database tables or
API applications that use the table functions for editing and/or display.

9308 The table "Concrete Slab Design - Flexural and Shear Data" has been expanded to present
the additional parameters required to compute shear capacity of a design strip. This
enhancement was implemented for the ACI 318-19, AS 3600-09, AS 3600-2018, CSA A23.3-
14, CSA A23.3-19 and Eurocode 2-2004 design codes.

9399 An enhancement was made in the database table "Shear Wall Pier Design Summary - AS
3600-2018" to now report the boundary-zone length when the section fails in design.

Design – Composite Beam
Enhancements Implemented
* Ticket Description

9342 An enhancement to composite beam design per all applicable design codes has been
implemented. For beams and girders with a uniform shear-stud distribution, the output now
includes a breakdown explaining how the maximum number of shear studs that can fit was
computed.

Design – Concrete Frame
Enhancements Implemented
* Ticket Description

8752 An enhancement was made for Eurocode 2-2004 shear wall design report by changing the
nomenclature of VRc and VRd in the pier and spandrel shear design table to VRd,c and VRd,
max respectively.

8775 An enhancement has been made to the concrete beam design code "Eurocode 2-2004" in
which the tan(theta) is now optimized for DCM and DCL frames per EN 1998-1:2004 even
where there is a seismic load. Previously, tan(theta) was not optimized for cases with
seismic load irrespective of framing type. It is still taken as 1 for DCH beams with a seismic
load. The previous results were slightly conservative. Also, because of tolerance issues, and
only on rare occasions, the design could show shear failure when the tan(theta) was
optimized for non-seismic cases. This latter issue is also fixed.

8854 An enhancement has been made to the concrete frame design codes "Eurocode 2-2004" and
"Italian NTC 2008" in which the joint shear details and the beam/column capacity ratios are
now reported in more detail in the “Design Details: ETABS Concrete Frame Design” form.
This was only a reporting change and design results were not affected.
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* Ticket Description
8855 An enhancement has been made to the concrete frame design to make the reporting of the

joint shear details and the beam/column capacity ratios more consistent and complete in
the “Design Details: ETABS Concrete Frame Design” form. Now these results will only be
reported at the top station of the columns, and only for certain codes and under the
appropriate conditions. When these results are not reported (including at stations other
than the top of the column), a message listing the required conditions will be provided. This
affects the ACI 318-19, ACI 318-14, ACI 318-11, ACI 318-08, AS 3600-2009, AS 3600-2018,
CSA A23.3-14, CSA A23.3-19, IS 456-2000, KBC 2009, KBC 2016, Mexican RCDF 2004,
Mexican RCD 2017, TS 500-2000 and TS 500-2000(R2018) design codes. This is only a
reporting change and design results are not affected.

9080 An incident was resolved for the concrete frame design reinforcing bar display where the
total longitudinal rebar displayed through the menu Display Beam Design > Longitudinal
Rebar Total did not match with that displayed through the menu Display Design Info > Total
Longitudinal Reinforcing. The latter values were correct. This was a display issue that only
affected the command Display Beam Design > Longitudinal Rebar Total. No other results
were affected.

Design – Shear Wall
Enhancements Implemented
* Ticket Description

9054 An enhancement was added for AS 3600-2018 shear wall design code where boundary zone
length now considers Section 14.6.2.3. Boundary zones will now report the maximum
dimension from max{0.15Lw, 1.5tw} and the distance where compression stress exceeds
0.15f'c to the pier edge when number of stories are greater than 4.

Design – Steel Frame
Enhancements Implemented
* Ticket Description
* 5208 An enhancement has been made to include the Eurocode 4-2004 composite column design.

7211 An enhancement has been made to the Canadian steel frame design according to the CSA
S16-19 and CSA S16-14 codes in which the section class ("H" or "C") of the HSS box and pipe
sections can now be overwritten in the overwrites form. This enhancement simplifies the
class determination and calculation of the power n of HSS sections which is used for axial
compression capacity calculation per CSA 13.3.1 for flexural-buckling mode. By default, n is
taken as 1.34. However, if a section name prefix is "WWF" for an I-shape, n is taken as 2.24.
For box and pipe sections, if the section name prefix is "HSS" or "HS" and the name postfix is
"H," the value of n is taken as 2.24. If the postfix is "C" instead of "H," n is taken as 1.34 for
box and pipe sections. For all other sections, n is taken as 1.34, except when any plate
thickness is greater than 25.4mm, n is taken as 1.0. With this enhancement, the HSS section
name does not need to be modified with a postfix anymore. By default, the overwrite item
'Is HSS section Class H?' is taken as 'Program Determined', meaning the previous procedure
remains in effect. If the section is not a box or pipe section, or if the member is not
overwritten, there is no change in the result. The value of n for torsion or torsional-flexural
buckling mode is taken as 1.34 per CSA 13.3.1, and unaffected by the changes in this ticket.

* 8676 An enhancement has been made to add steel frame design based on the AS 4100:2020 code.

Detailing
Enhancements Implemented
* Ticket Description
* 6634 Detailed reinforcement from beams, slabs, column stacks, and wall stacks can now be

exported from ETABS to Revit through the CSiXRevit 2023 plug-in to Revit 2023. Currently
this is a one-way transfer: the rebar cannot be imported into ETABS from Revit. Previously
this feature was available from ETABS to Revit using both CSiDetail and CSiXRevit. Now
CSiDetail is not required. This feature requires CSiXRevit v2023.1.0 or later.
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* Ticket Description
* 8779 Detailing in ETABS can now handle multiple towers. Previously detailing was only available

for the first tower of models that enabled the multi-tower option.
* 8780 Detailing of concrete and steel structures, as well as the production and management of

schematic design drawings, are now available from a new Detailing menu inside ETABS.
Previously, these features were provided by the separate product CSiDetail v18 that worked
with ETABS v19 and ETABS v20. With ETABS v21, CSiDetail is no longer needed. Detailing
results can be displayed in the model windows and used for further design checks, as well as
for producing drawings. Detailing is available for beams, slabs, column stacks, and wall
stacks.

9314 For the detailing of concrete beams, slabs, column-stacks and walls-stacks, rebar spacing is
now rounded to the nearest multiple of 1/2 inch (in US Customary units) or to the nearest
multiple of 5 mm (in SI/MKS units), wherever practicable.

Documentation
Enhancements Implemented
* Ticket Description

8724 The ETABS Help documentation topic "Link/Support Directional Properties" has been
updated to include information about the "Fixed Length Damper" option added in ETABS
v20.2.0 for Exponential and Bilinear dampers.

8827 An incident was resolved in the concrete frame design manual for Australian code “AS
3600:2018” where the manual stated that phi for pure compression was 0.60 while per the
design code, it is 0.65. Also, Item 2 of Table 2.2.2 has been updated to reflect AS 3600
amendment 2. This is a documentation update only. ETABS was also updated to improve the
item description of concrete frame and shear wall design preferences for AS 3600-2018
code. These changes were only cosmetic. No results were affected.

External Import and Export
Enhancements Implemented
* Ticket Description

7177 The "Export to Perform3D Model" functionality has been expanded to automatically create
structure sections in the exported Perform3D model based on ETABS pier assignments. A
pair of structure sections will be created that capture the response at the top and bottom of
each labeled pier at each story level.

7883 Two related enhancements to the export of models to Revit .EXR files have been
implemented: (1.) Joist end reactions are now exported. (2.) Reactions are now exported in
the units set by user for the display of forces with the precision requested by the user.
Previously they were always exported in database units (the internal units of the model
when it was first created).

8807 An enhancement was made where beam rebar covers were being written as default values
when exporting to a SAFE (.F2K) file. Now, ETABS will use the specified rebar covers for
beams when exporting to a SAFE (.F2K) file.

9025 An enhancement to the import and export of IFC files has been implemented. ETABS
mirrored frame objects and frame objects with a mirrored section are now exported to
IFC2x3 with an IfcDerivedProfileDef that refers to an IfcCartesianTransformationOperator2D
specifying a mirror operation and exported to IFC4 with an IfcMirroredProfileDef section.
Conversely IFC architectural objects and structural analysis objects whose section is an
IfcDerivedProfileDef that refers to an IfcCartesianTransformationOperator2D specifying a
mirror operation or an IfcMirroredProfileDef are now imported as mirrored frame objects.
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* Ticket Description
9110 An enhancement to the export of IFC files has been implemented. Several recently

deprecated IFC objects are no longer output when an ETABS model is exported. Line and
area objects are no longer exported to the architectural coordination view as
IfcColumnStandardCase, IfcBeamStandardCase, IfcMemberStandardCase,
IfcWallStandardCase, IfcSlabStandardCase objects and are exported as IfcColumn, IfcBeam,
IfcMember, IfcWall, or IfcSlab objects because the "standard case" subtypes of these objects
have been deprecated in IFC 4x1. However, all the "standard case" subtypes of these objects
are still imported from IFC files when present. Section properties with a trapezoidal type are
now exported as IfcArbitraryClosedProfileDef sections instead of IfcTrapeziumProfileDef
sections because IfcTrapeziumProfileDef has been deprecated in IFC 4x3. Note that
IfcPTrapeziumProfileDef sections were never imported.

9112 Two related enhancements to the export of frame section properties to IFC were
implemented. (1) Several frame section property types not previously exported are now
exported. These include: concrete angles, concrete precast I, concrete cross, concrete tee,
cold formed C, cold formed Z, and cold formed hat. Previously these profiles were exported
as a generic IfcProfileDef object with a name matching the ETABS section name. (2) Angle
section fillet radii, if defined, are exported.

Graphics
Enhancements Implemented
* Ticket Description

9430 The size of the joints drawn in the model window is now consistently limited to the
Maximum Graphic Font Size specified using the command Options > Graphics Preferences.
For DirectX graphics mode, joints will always use this maximum font size. For Classical Plus
(GDI+) graphics mode, joints may be smaller toward the back of the structure. Previously the
joint size could be too large compared to the text for certain models.

Installation and Licensing
Enhancements Implemented
* Ticket Description
* 8759 The version number has been changed to 21.0.0 for a new major release.

Loading
Enhancements Implemented
* Ticket Description
* 1368 An enhancement was made to allow loads assigned to null lines and null areas applied in any

local or global direction to transfer to the underlying structural floors. In earlier versions only
loads in the gravity direction were transferred.

* 8963 Automated wind loads have been implemented for the ASCE 7-22 standard.
* 8965 The automated response-spectrum function has been implemented for the ASCE 7-22

standard.
* 9172 Automated seismic loads have been implemented for the ASCE 7-22 standard.

9352 An enhancement was made for the KBC 2016 auto-wind load pattern to continue computing
wind loads when the building height becomes larger than the Zg value specified in KBC 2016
table 0305.5.4 for a given wind-exposure class. A warning will then be issued during analysis
to alert the user that the building height exceeds the code limit, and the load will be
computed using parameters valid for building heights less than Zg. Previously, no loads were
applied in this case.

* 9379 Enhancement has been made to add auto-wind loads, auto-seismic loads, and response-
spectrum function based on NBCC 2020.
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Results Display and Output
Enhancements Implemented
* Ticket Description
* 5946 An enhancement was made to make colors consistent between the hinge definition forms

and the various hinge displays for states and status, including hinges shown on the
deformed shape and in hinge-response plots, and including the response of individual fibers
where applicable. The colors are editable using the command Options > Graphics Colors >
Output.

* 8870 An enhancement was made to include the nonlinear shear-material state and status output
for general wall hinges in the database tables (Display > Show Tables), deformed shape
display (Display > Deformed Shape), and performance-check output (Display > Display
Performance Check). The state and status output is dependent on the Point IDs and
acceptance-criteria strains specified in the nonlinear material properties of the nonlinear
shear material used in the general hinge definition. A new table "General Wall Hinge NL
Shear State" is added for this enhancement.

8923 An enhancement was made to improve the speed of viewing Performance Check D/C ratios
in the display (Display menu > Display Performance Check).

* 9086 An enhancement has been implemented to show the cracked section modifiers for beam
and floor objects in the database tables (Display > Show Tables). The newly added tables
"Frame Element Cracked Section Modifiers" and "Shell Element Cracked Section Modifiers"
will be available for a nonlinear static or staged construction load case with the floor
cracking feature enabled.

Structural Model
Enhancements Implemented
* Ticket Description

7877 An enhancement has been made to make any assigned mass additive when floor objects
overlap. Previously any mass assigned to overlapping floor objects was only taken from the
governing object. Self-mass from the object properties still only considers the mass from the
governing object.

* 9184 An enhancement has been made to account for tributary PT tendon in finite element-based
design of slabs. The strip-based design already accounted for the tendons within the strip
when designing for additional reinforcement needed. The same tributary PT tendon in
individual slab elements is also now used for slab cracked (short and long term) deflection
analysis.

User Interface
Enhancements Implemented
* Ticket Description

8224 An enhancement has been made to the user interface to speed up display and editing of
time-history and response-spectrum functions with many (e.g., more than tens of
thousands) data points.

8746 An enhancement was made to add filtering capability to the forms displayed for the Change
Design Section commands accessed from the Design menu for Steel Frame, Concrete Frame,
Composite Beam, Composite Column, and Steel Joist design.

8811 A new "Diaphragm Forces" button has been added to the main toolbar that corresponds to
the command Display > Force/Stress Diagrams > Diaphragm Forces.

9072 A change has been made to the language of the message that is presented when running a
plugin from the Tools menu. It is also now possible to set the message for each plugin to not
display during subsequent runs.
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* Ticket Description
9208 When plotting material time-dependent behavior using the Time Dependent Properties for

Concrete and Material Property Time Dependence Plot forms (Define menu > Material
Properties), the specified user scale factors are now included in the plots of stiffness,
strength, creep, and shrinkage against time. Previously, these factors were not included in
the plots, even though they were being used in analysis. This change does not affect analysis
results.
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Analysis
Incidents Resolved
* Ticket Description

8722 An incident was resolved where a nonlinear static load case applying one or more multi-step
load patterns (i.e., auto-lateral loads with multiple directions or eccentricities) was not able
to converge after the first stage of the analysis. This issue only affected nonlinear static load
cases that were indicated in the analysis log file as having independent (rather than
sequential) stages. Affected load cases should be rerun in the most recent version of the
program.

8785 An incident was resolved where the floor-cracking scale factor was not applied when short-
term floor-cracking analysis was enabled in a nonlinear static load case using Slab design
codes BS 8110-97, Hong Kong CP 2013, IS 456:2000, or Singapore CP 65:99. This issue did
not affect short-term floor-cracking analysis with other Slab design codes. Floor-cracking
analysis with long-term effects was not affected for any Slab design code.

8848 An incident was resolved where, when a general wall hinge with only nonlinear shear
properties was assigned to a wall object, an error message would occur during analysis and
prevent analysis from running. This issue occurred when the model had another wall object
assigned with either a vertical wall hinge or a general wall hinge which has at least one P-M3
hinge.

8853 An incident was resolved where the reported joint reactions did not always include the load
applied to the joints for linear direct-integration time history load cases, whether the load
was applied directly on the joint or on connected elements. This issue only affected the
reported reactions at restrained joints that included force loads, acceleration loads, and/or
temperature/strain loads from connected elements, as well as force loads on the restrained
joints themselves. Similarly affected were the reactions due to ground-displacement loads
applied at joints grounded by springs. Reactions due to displacement loads on joints
grounded through restraints or one-joint links were not affected. This was a reporting error
only. No other results were affected.

8980 An incident was resolved where the analysis could not be cancelled from the analysis
monitor in the following situation: The Analysis Process Option had been changed to
"Separate Process", then the parallel Load Case Option had been enabled, and then the
Analysis Process Option had been changed back to "Auto" or "GUI Process" before running
the analysis. These options can be set using the command Analysis > Analysis Options >
Advanced SAPFire Options. When this occurred, the analysis could still be cancelled using
the Cancel button on the main window instead of on the analysis monitor.

* 9106 An incident was resolved where running nonlinear staged-construction analyses on
moderate- to large-sized models that produced a large (hundreds of MBs) analysis file for
storing staged results (.Y file) sometimes caused an abnormal termination of the software.
This was not common, but when it occurred, results were not available.

API
Incidents Resolved
* Ticket Description

6456 An incident was resolved for the Application Programming Interface (API) where assigning a
Pier or Spandrel label to area or line objects through the API would not immediately update
the display of Pier or Spandrel results if the analysis was already run. The results would
update if the view was manually refreshed in the graphical user interface.

9028 An incident was resolved for the Application Programming Interface (API) where calling
certain response-recovery functions many times (e.g., tens of thousands of times) while
requesting a large amount of data (e.g., step-by-step results for tens of thousands of steps)
resulted in growing, and possibly excessive, memory usage. The following functions in the
cAnalysisResults interface were affected: AreaStressShell, AreaStrainShell,
AreaStressShellLayered, AreaStrainShellLayered, AssembledJointMass, FrameForce,
FrameJointForce, GeneralizedDispl, LinkDeformation, LinkForce, LinkJointForce,
PanelZoneDeformation, PanelZoneForce, SectionCutAnalysis, and SectionCutDesign.
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* Ticket Description
9083 An incident was resolved for the Application Programming Interface (API) where the

functions GetPreference, SetPreference, and SetOverwrite were returning error code 1 for
the IS 800-2007 and NZS 3404-97 steel frame design codes.

9187 An incident was resolved for the cross-product Application Programming Interface (API –
CSiAPIv1) where the following API functions did not update enumerations passed by
reference in the argument list: cPropArea.GetDeck, cPropArea.GetSlab, and
cPointObj.GetDiaphragm.

9220 An incident was resolved for the Application Programming Interface (API) where the
function cFrameObj.SetOutputStations did not change the Output Stations type to "Min
Number Station" when the API input parameter MyType was set to 2. The behavior of the
model agreed with the Output Stations settings shown in the graphical user interface and via
function cFrameObject.GetOutputStations.

9398 An incident was resolved for the Application Programming Interface (API) where: (1.) The
functions SetLoadDistributed for frame objects and SetLoadUniform for area objects did not
correctly set the loading direction when argument Dir was given as 10 or 11, which
correspond to gravity (-Z). This caused errors in displaying the loads and could cause the
analysis to fail to run. Now setting Dir to 10 or 11 specifies loading in the -Z direction, and
setting Dir to 6 or 9 specifies loading in the +Z direction. The corresponding get functions
GetLoadDistributed for frame objects and GetLoadUniform for area objects will return
positive load values and Dir equal to 6 or 9 for upward vertical loads, and will return positive
load values and Dir equal to 10 or 11 for downward vertical loads. Note that Dir set to 6 and
10 correspond to full vertical loads, while 9 and 11 correspond to vertical loads on the
horizontal projection of the object. (2.) The function SetLoadPoint for frame objects did not
correctly set the loading direction when argument Dir was given as 10, which corresponds to
gravity (-Z). This caused errors in displaying the loads and could cause the analysis to fail to
run. Now setting Dir to 10 specifies loading in the -Z direction, and setting Dir to 6 specifies
loading in the +Z direction. The corresponding get function GetLoadPoint for frame objects
will return positive load values and Dir equal to 6 for upward vertical loads, and will return
positive load values and Dir equal to 10 for downward vertical loads. Note that Dir set to 6
and 10 correspond to full vertical loads. Additionally, setting Dir to 7, 8, 9, or 11,
corresponding to the projected directions for uniform loads, is not applicable for point loads
and will now return an error code. Previously, they were available in both the functions and
documentation, and when used would erroneously apply load in the global Z direction. (3.)
The functions SetLoadUniformToFrame and GetLoadUniformToFrame for area objects are
not applicable in ETABS. Previously they were available but would not affect the model and
the analysis. Now they will return a code corresponding to not being applicable.

Database Tables
Incidents Resolved
* Ticket Description

8832 An incident was resolved where there was an inconsistency in the reported failure messages
between the “Concrete Slab Design - Flexural and Shear Data” and the “Concrete Slab
Design Summary - Flexural and Shear Data” tables. The “Concrete Slab Design - Flexural and
Shear Data” table was unable to show a failure message when failure occurred at the very
first station. This was only a display error, and the messages were correct in the “Concrete
Slab Design Summary - Flexural and Shear Data”.

8834 An incident was resolved where "Diaphragm Forces" table was not available for some
models.

9031 An incident was resolved where the tabular data for soil pressure could not be generated if
the area springs assigned in the model had stiffness specified for the local 1- and 2-
directions in addition to the local 3-direction.

9082 An incident was resolved where attempting to use the Interactive Database Editor to modify
the Design Overwrites tables for either beams or columns under any of the concrete design
codes would result in an error message. When this occurred, the design overwrite
parameters could not be updated. Design Overwrite parameters could be updated using the
corresponding menu command.
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* Ticket Description
9264 An incident was resolved where the table "Material Properties - Concrete Data" (Display

menu > Show Tables) was not able to show the time dependent type "AS 3600-2018" in the
TimeType column for concrete materials that were assigned this type. This issue also
affected interactive database editing (Edit menu > Interactive Database) where editing the
TimeType column to "AS 3600-2018" would set the concrete material to use time dependent
type "AS 3600-2009" instead of "AS 3600-2018".

9266 An incident was resolved where the composite beam design overwrites table was not
getting generated if the shear-connector pattern was user-defined with zero number of
additional segments. This issue affected the overwrites table for all design codes.

9276 An incident was resolved where shell section property assignments edited in the interactive
database might be reset to their previous assignments when the analysis was run. This issue
affected both slab and wall objects. When this issue occurred, the analysis results were
consistent with the section property assignment shown after analysis was completed.

9467 An incident was resolved where the Selection-Only option for displaying tables was not
working for the table "Link Object Connectivity".

Design – Composite Beam
Incidents Resolved
* Ticket Description

8839 An incident affecting composite beam design per the AISC 360-16 design code was resolved.
Beams without any positive major-axis bending, such as cantilevers, and with a span greater
than 30 ft. were not designed by the Composite Beam Start Design/Check command. When
this occurred, an error message informed the user of the issue and no results were available
for the affected beams. Attempts to design the affected beams interactively triggered an
abnormal termination, with again no results available. Beams with any amount of positive
major axis bending or with a span of 30 ft. or less were not affected. This incident affected
all versions of ETABS capable of designing composite beams per the AISC 360-16 design
code, i.e., ETABS v17.0 to v20.3.0.

8869 An incident affecting composite beam design output was resolved. The "Strength Checks"
section of the output was missing for composite beams with four or more web openings
when the selected design code was AISC 360-16 and "Consider Axial Force" option was
selected. This affected all versions of ETABS capable of considering axial forces when
designing composite design, i.e., ETABS v18.0.0 to v20.4.0. The omission was a reporting
problem only, and no other results were affected.

8934 An incident was resolved for encased composite column design based on the AISC 360-16
code where the tau_b factor could be artificially small when the embedded steel section
alone was classified as a slender section.

* 8979 An incident was resolved for composite beam design where beams with bottom flange cover
plates were not designed when the Composite Beam Design Start Design/Check command
was run, and instead an error message was displayed informing the user. Attempting to
design such beams interactively resulted in an abnormal program termination. When this
occurred, the problem was obvious in that no designs were available. This incident affected
version 20.0.0 to 20.3.0.

9101 An incident was resolved for composite column design per the AISC 360-16, ASIC 360-10,
and Chinese 2010 codes where beams that were assigned to be designed as composite
columns did not display results in the model windows (commands Design > Composite
Column Design > Start Design/Check or Display Design) or in the tabular output. However,
detailed design results were shown for beam members when right-clicking on the beam
when the design results were displayed in a model window. Now design results are
consistently available for beams assigned for composite column design.
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* Ticket Description
9280 An incident was resolved for composite beam design where the Force Composite value of

the Beam Type overwrite was ignored for any beam for which the following happened: (1.)
The beam section was adequate without any composite action. (2.) The Force Composite
overwrite had been specified for the beam. (3.) The beam had been designed interactively
with the user changing the percentage of composite action from the minimum percentage
of composite action specified in the Composite Beam Design Preferences or Beam Overrides
to a greater percentage greater and then back to its initial value. When all of the above
occurred, the composite designs produced by ETABS for the affected beams were still fully
valid but ignored the overwrite. The beams could be made composite through interactive
design. This incident affected all versions of ETABS that feature the Force Composite
overwrite.

Design – Concrete Frame
Incidents Resolved
* Ticket Description

7888 An incident has been resolved in the Russian concrete frame design code SP 63.13330.2011,
in which case, the “Snow Load Duration Factor” preference did not affect the calculation of
long-term moment Ml1 in strength calculation. The total load moment was correct. This
affects the eta factor calculation as it affects the PhiL, Kb, D, and Ncr calculations (SP63
8.1.15).

8885 An incident was resolved for concrete frame design codes "Eurocode 2-2004" and "Italian
NTC 2008" in which the beam/column capacity ratio was being calculated as the ratio of the
sum of the design moment capacities of the beams (with design values of gamma_c and
gamma_s) to the sum of nominal moment capacities of columns (with gamma_c = 1,
gamma_s = 1). In both cases, the design values of the moment capacities with appropriate
strength reduction factors gamma_c and gamma_s are now used per EN 1998-1:2004
sections 4.4.2.3(4) and 5.2.3.3(2). The previous implementation was unconservative.

8972 An incident was resolved for Mexican RCDF 2014 and 2017 concrete frame design codes
where computation of the u factor was incorrect. The u factor was computed based on
sustained and total moments instead of sustained and total axial load.

9003 An incident was resolved for the concrete frame design code per the "Chinese 2010" where
an error message was sometime displayed during the design process while designing
concrete columns. This only occurred when there was a seismic load present, the Seismic
Design Grade was assigned as Super I, Grade I, II, III, or IV, and there was a column above the
column being designed/checked. When this occurred, design results were not available for
the affected column(s). All other members were properly checked and the results were not
affected. This error affected versions 20.2.0 to 20.3.0.

* 9044 An incident was resolved for concrete frame design according to Eurocode 2-2004 and
Italian NTC 2008 where the axial compression ratio was computed and reported as zero, and
the corresponding result "Ratio Okay?" was reported as "No" in the design details. This error
only occurred when the reinforcement was selected to be checked in the column section
definition. The ratio was correctly reported when reinforcement was set to be designed.

* 9074 An incident was resolved for the concrete frame design code ACI 318-19 where the potential
plastic zone was not identified correctly at the right (J) end of the beam while the potential
plastic zone was identified correctly at the left (I) end of the beam per ACI 318-19 18.6.4.1.
This caused the design to not set phi*Vc to zero at the right end of the beam if the capacity
shear Vp is more than half of the total design shear, which was incorrect for Special moment
frames per ACI 318-19 18.6.5.2. There was no error if the frame type was NonSeismic,
Ordinary, or Intermediate. This issue was introduced in ETABS v19.0.1 when ACI 318-19 code
was introduced. Results for affected models in v19.0.1 to v20.3.0 could have been
unconservative.

9179 An incident was resolved where tracing the column above for Beam/Column capacity ratio
calculations in Concrete Frame design was sometimes missing if the column spanned over
two or more stories.
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* Ticket Description
* 9416 An incident was resolved for concrete beam design per the TCVN 5574:2012 code where the

area of longitudinal rebar due to flexure was incorrect when the model database units were
not in N-mm. Note that the database units are those in effect when the model is created or
imported, and these are reported in the analysis .LOG file.

9441 An incident was resolved for Mexican RCDF 2017 concrete frame design code where shear
capacity of a frame was using fc* instead of f'c. This always yielded a conservative design.

Design – Shear Wall
Incidents Resolved
* Ticket Description

2458 An incident was resolved for concrete shear wall design code “Chinese 2010” where, for the
boundary-element check for N/(fc*A), the compression force N in the wall should be the
design value of the representative gravity load as can be calculated from the definition of
the mass source with an additional multiplier of 1.3. Typically, this value of N would be
calculated from 1.3*(1.0DL+0.5LL). Previously, N was being determined separately from the
gravity contribution for each design load combination rather than being constant for all
design combinations. Now, a constant value of N will be determined as follows: (1) If the
default mass source uses dead- and live-load patterns, then N will be calculated as 1.3 times
the compression force from the combination of dead and live load as specified in the mass
source. (2) If the default mass source does not use gravity load patterns, then N will be
calculated from an internal load combination of 1.3*(1.0DL+0.5LL), where DL and LL are the
available dead-load and live-load patterns. (3). For either (1) to (2) to work, load cases
corresponding to the relevant dead-load and live-load patterns must have been analyzed
and included in at least one design load combination, regardless of scaling. This is the most
common case. If that is not the case, then the previous behavior will be used where the
force N will be taken from each individual design load combination.

8753 An incident was resolved for Eurocode 2-2004 shear wall design where the design
preference "Gamma (Shear)" was inadvertently exposed, even though it was not being used.
This parameter has now been removed from the design preferences, and the design
preference table has been updated accordingly. No results are affected.

* 8828 An incident was resolved in the Australian concrete shear wall design code “AS 3600-2018”
where the capacity shear design could be unconservative in the case where wall was
designed, the flexural required reinforcement was more than the provided rebar in the pier,
and the 1.6Mu/M* factor was less than the structural ductility factor divided by the
structural performance for concrete member. For models with walls where these conditions
are met, it is recommended to redesign the ductile walls with the new version of the
software.

8831 An incident was resolved in the Indian shearwall design code “IS 456-2000” where the
design shear strength of concrete in walls for Hw/Lw > 1 was always taken as
K2*sqrt(fck)*(Hw/Lw + 1) / (Hw/Lw - 1) instead of the maximum of that value and
K3*sqrt(fck), as per IS 456-2000 section 32.3.4. This has been corrected. The manual was
already correct. Previous results were conservative when K3*sqrt(fck) was the larger of the
two values.

* 9437 An incident was resolved for the concrete shear-wall design code ACI 318-19 where the
shear capacity of a wall pier was not calculated correctly when a net tensile force was
present in the pier and the model database units were not lb-inch. This only affected the
shear rebar calculation, and the results could have been unconservative for certain units.
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Design – Steel Frame
Incidents Resolved
* Ticket Description

5309 An incident was resolved for the AISC 360-16 steel frame design code where the reported
HSS axial compression capacity was wrong for the slender sections when the member was in
tension. The reported compression capacity was based on the unreduced section area. Now
the reported compression capacity is based on reduced area. This was a reporting issue only
and had no effect on the PMM stress-ratio calculation

8729 An incident was resolved for the AISC 360-16 steel frame design code in which the
slenderness limit for Pipe (Round HSS) sections for the moderately ductile limit of a brace,
beam, or column was taken as 0.062 E/(Ry*Fy) based on Table D1.1. Now the limit is taken
as 0.062 E/(Ry*Fy) for braces (Table D1.1) and 0.077 E/(Ry*Fy) for beams and columns
(Table D1.1 Footnote [c]). The documentation has been updated accordingly. The previous
results were slightly conservative.

8871 An incident has been resolved in steel frame design code "AISC 360-16" in which when using
SCBF the program reports "Section is not seismically compact for moderately ductile
members" instead of "Section is not seismically compact for highly ductile members" per
AISC 341-16 section F2-5a for columns and braces.

8961 An incident was resolved where the Design Overwrites "Yes/No" type items were displayed
as blank for all frame design codes (steel, concrete, composite, joist) and wall design codes
when the form was opened and none of the Design Overwrite had been overwritten. The
design results were not affected corresponding parameters were taken from the Design
Preferences, as expected when they are not overwritten. Only the Design Overwrites form
appeared to be incompletely filled.

8970 An incident was resolved for steel frame design code "AISC 360-16" when using OCBF where
the design reported "Section is not seismically compact for moderately ductile members
(AISC 341-16 E3.4a, 5.2b, Table I-8-1)" instead of "Section is not seismically compact for
highly ductile members (AISC 341-16 F1.5a, D1.1, Table D1.1)" for brace members.

9035 An incident was resolved for the Eurocode 3-2005, Italian NTC 2008, and Italian NTC 2018
steel frame design codes in which the calculation of the elastic critical moment, Mcr, was
missing the square in the term (KLT/kw)^2. Previously, in common cases, it resulted in a
slightly higher estimate of the global buckling moment capacity and the design being
marginally unconservative. This affected all cross sections except for the box, pipe,
rectangular, and circular shapes whose lateral-torsional buckling effects are not considered.
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* Ticket Description
9064 An incident was resolved for steel frame design that addressed several issues related to the

editing of Design Preferences and Design Overwrites: (1.) For the Design Preferences of
codes AISC 360-16, Italian NTC 2008, Italian NTC 2018, KBC 2009, and KBC 2016: Editing
these data in these interactive tables did not actually update the corresponding Design
Preference parameters used for design. (2.) For the Design Preferences of code AISC LRFD
93: parameters PhiBend, PhiComp, PhiTension, PhiShear, PhiCompAng could not be updated
through interactive table editing. (3.) For the Design Preferences of codes AS 4100-1998 and
NZS 3404:1997: parameters PhiComp, PhiTY, PhiTF, PhiShear could not be updated through
interactive table editing. (4.) For the Design Preferences of codes CSA S16-14 and CSA S16-
19: parameters PhiComp, PhiTension, PhiShear could not be updated through interactive
table editing. (5.) For the Design Overwrites of all codes: none of the Overwrite parameters
could be updated through interactive table editing. (6.) For the Design Overwrites of codes
Italian NTC 2008 and NTC 2018: The coefficient "C1" has been renamed to "Psi" to be
consistent with the design codes. This applies to the tables and to the Design Overwrites
form in the graphical user interface. (7.) For the Design Overwrites of codes Italian NTC 2008
and NTC 2018: The parameters C2, C3, ZaProgDet, Za, ZsProgDet, and Zs have been added to
the tables for interactive database editing. (8.) For the Design Overwrites of codes Eurocode
3-2005, Italian NTC 2008, and NTC 2018: The parameters kw, Mcr, ZaProgDet, Za, ZsProgDet,
and Zs were not being imported from the *.E2K and $ET model text files, but instead were
being set to default values. (9.) For the Design Overwrites of codes Eurocode 3-2005, Italian
NTC 2008, and NTC 2018: The values of Za and Zs were always set to positive values, even
when a negative value was specified in the Design Overwrites form. They are now correctly
set to the specified value, which can be positive, negative, or zero.

9201 An incident was resolved for the CSA S16-19 and CSA S16-14 steel frame design codes where
the axial capacity of Section-Designer sections was very low for flexural-torsional buckling,
and this could result in unreasonably high demand-capacity ratios. Flexural-torsional
buckling is not available for Section-Designer section or general sections, so flexural buckling
is now reported instead. In addition, the Cr value presented in the design report under table
"Axial Capacities for Different Conditions" was not converted for force units, so the value
could have been wrong. This latter issue was just a reporting error and design was not
affected.

* 9222 An incident was resolved for steel frame design codes AISC 360-10, AISC 360-16, AISC 360-
16, KBC 2016, and KBC 2009 where the torsional capacity of box sections was calculated
incorrectly when the web and flange thicknesses were different. The calculated phi*Tn was
higher (unconservative) when the thickness of the web was smaller than the thickness of the
flange. When the thickness of the web was larger than the thickness of the flange, the
calculation of phi*Tn was correct.

9260 An incident was resolved for certain steel frame design codes where the reported beam end
shear was reported correctly but the corresponding load combination names were incorrect.
The affected codes were "AISC 360-05", "AISC 360-10", "AISC 360-16", “CSA S16-14”, “CSA
S16-19”, "KBC 2009", "KBC 2016", "Eurocode 3-2005", "Italian NTC 2008", "Italian NTC
2018", "Chinese 2010", and "Chinese 2018". This was a reporting issue only. No other design
results were affected.

9265 An incident was resolved for steel frame design codes "Eurocode 3-2005" and "Italian NTC
2018" where the design used the (EN 1993-6 Annex A) equation instead of the EC3 6.3.3(4)-
6.62 equation in the check for the combined effect of axial compression and bending even in
the absence of torsion. The EN 1993-6 Annex A equation is applicable only in the presence of
torsion. The resulting PMM ratio was slightly conservative, and the difference was generally
insignificant.
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* Ticket Description
9275 An incident was resolved that addressed several issues for the Eurocode 3-2005, Italian NTC

2008 and NTC 2018 steel frame design codes: (1.) For the Italian NTC 2008 and NTC 2018
codes, the equivalent moment about z-axis bending was always taken as zero for members
with uniform bracing assigned in the Lateral Bracing option of the design. For the case where
the design is governed by the global buckling and combination equation C4.2.32 using
Method A or Method Both for the PMM interaction, this resulted in an unconservative
design. (2.) The calculation of the C1, C2, and C3 factors has been improved for Eurocode 3-
2005, NTC 2008 and NTC 2018 steel frame design. It now includes a more appropriate
determination of the unbraced length and the moment diagram, resulting in a less
conservative value of the C1 factor. Previously, the design algorithm was not identifying the
bracing point at the intersection of two frame members when this intersection was within
the length of a member that was not divided into two elements and whose design was
performed over the entire length. Consequently, the condition of the moment diagram used
to determine C1, C2, and C3 was incorrect. Now the priority for determining the unbraced
length is as follows: (2a.) The unbraced length (and resulting brace locations) assigned as
Design Overwrites will take the first priority. (2b.) If it is not specified in the Overwrites, the
Design > Lateral Bracing option will be considered next. (2c.) If it is not assigned in the
Overwrites or the Design > Lateral Bracing option, then the unbraced length will be
internally determined by the connection between frame members. By specifying a ratio for
an unbraced length type using the overwrites, the number of brace points will be internally
determined, and the brace point locations will be arranged such that they are symmetric
about the center line of the member and the distance between the adjacent braced points is
the specified unbraced length (L). For the brace points closest to the ends of the frame
element, they will be placed at a distance (L_end) that is always less than or equal to the
specified unbraced length L (i.e., L_end <= L). However, for the design stations that are
within this L_end, the brace points are the end joint of the element and the other point is at
the location that is of the unbraced length L away from the end joint. These brace points are
used only to determine the shape of the moment diagram needed to compute intermediate
design parameters. The unbraced length L is still used to calculate the axial compression and
moment capacity under consideration of global buckling. (3.) For the Eurocode 3-2005, NTC
2008 and NTC 2018 codes, an option to select the method for calculating C1, C2, and C3 has
been added in the Design Overwrites. Choices include the method specified in EN 1993-1-
1:1992, the method applied to general moment diagrams as described in Section F.1(c) of
the AISC 360-16, and direct input by the user. In addition, the problem with displaying the
data in the Steel Frame Lateral Bracing - Uniform table was also resolved. Previously, there
was no data shown in this table although there were frame elements assigned with the
uniform bracing through Design -> Steel Frame Design -> Lateral Bracing.

9297 An incident was resolved for joist design where right-clicking on a member to view the
design details after running the design would sometimes fail display the results for members
that used an auto-select list for the section property. This was just a reporting issue and
design results were not otherwise affected.

* 9420 An incident was resolved for the AISC 360-16 steel frame design code where the HSS
moment capacity was computed incorrectly when the section was slender. The previous
calculations were unconservative.
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Detailing
Incidents Resolved
* Ticket Description

8677 An enhancement was made to for all concrete frame design codes where the reported
longitudinal rebars for detailing the beams were the top and bottom rebars required for
flexural strength only. Now the reported top and bottom total longitudinal rebars for
detailing are calculated from the flexural-, torsional-, and shear-strength requirements (for
the applicable codes like "AS 3600-2018", "CSA A23.3-14","CSA A23.3-19", "Eurocode 2-
2004", and "SP 63.13330.2012"). The display also shows "Torsional Longitudinal
Reinforcing", "Shear Longitudinal Reinforcing", and "Flexural Longitudinal Reinforcing" for
the codes where shear and torsion affect the longitudinal rebar design. In addition, the
shear stirrups previously only accounted for shear-strength requirements. Now the reported
"Shear Plus Torsion Reinforcing" stirrup rebars includes both the shear and torsional
strength requirements. The reported "Shear Reinforcing" stirrup rebars in the beam are
those for shear strength, as before. The previous design calculations were correct, only the
detailing was affected. Note that the previous behavior affected CSiDetail v18.2.1, but the
new behavior affects ETABS v21.0.0, since detailing is now integrated in ETABS.

Drafting and Editing
Incidents Resolved
* Ticket Description

8900 An incident was resolved where the command Quick Draw Area Around Point (Plan) was not
showing the "Trim at Slab Edges?" option in Properties of Object form that sets the drawing
options. This command is available from the submenu Draw > Draw Floor/Wall Objects.

8919 An incident was resolved where the software would terminate abnormally when defining a
working plane if the spaces were included at the end of the name specified for the working
plane.

External Import and Export
Incidents Resolved
* Ticket Description

5999 An incident was resolved where, for an ETABS model exported to Perform3D, the hinge-
deformation scale factors specified in ETABS single-degree-of-freedom M3 hinges were not
exported. This behavior has been corrected so that the hinge deformations in the exported
Perform3D model account for the ETABS hinge-deformation scale factors. Models where the
hinge-deformation scale factors in ETABS M3 hinges were set to unity were not affected.
Results in Perform3D agreed with the model as imported. This issue was corrected for
v20.3.0, but inadvertently omitted from the Release Notes.

8408 An incident affecting the import of Revit projects with a single story level marker defined has
been resolved. When the import of an .EXR file generated for such a project was initiated in
a newly created ETABS model and not from the ETABS Welcome screen, only part of the
structure was imported. This affected all versions of ETABS capable of importing Revit .EXR
files, up to v20.1.0. When the issue occurred, it was visually obvious. There were two
possible workaround: (1.) draw a second story level marker in the Revit project, thereby
defining a story height; or (2.) initiate the import from the ETABS Welcome screen, as
illustrated in the CSiXRevit Manual. This issue was resolved with v20.2.0 but inadvertently
omitted from the Release Notes.

8757 An incident was resolved where response spectrum load cases exported to SAFE did not fully
consider the additional eccentricity loads when “Export Floor Loads and Loads from Above”
option was selected. Now the eccentricity effects will be fully exported to SAFE versions
20.3.0 and later.
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* Ticket Description
8960 An incident was resolved where, for concrete Tee and L frame sections, the option to ignore

flange for area, weight, and mass was being ignored when a model was exported in any of
the available formats (text, Excel, Access, XML). Consequently, the option was being set to
the default value when an exported model was imported back into the software.
Additionally, this option was also not available in table display and for interactive editing.

9002 An incident was resolved where the data for Shell Layer Stresses and Shell Layer Strains
were not getting exported to the .E2K and .$ET text files. Consequently, importing an .E2K
(or .$ET) file for a model where Shell Layer Stresses/Strains were included in named plot
functions would result in an error and the definition(s) for Shell layer Stresses/Strains would
get lost. The functionality to export/import shell layer stresses/strains and associated data
as part of named plot functions has now been added.

9014 An incident was resolved where a line or quad gauge object that spanned multiple stories
would be reduced to one story after the model was exported to a text file using File menu >
Export > ETABS .e2k Text File and then re-imported. This issue only occurred after exporting
and re-importing a text file, and the change in gauge geometry was reflected in the display
of the imported model.

9016 An incident was resolved where exporting data for wall force/stress/strain plot function(s) to
a text file (.E2K) would cause an index out of range error.

9079 An incident was resolved to correct an issue with the quick draw of curved walls using an
imported architecture layer.

9111 Two related incidents affecting the export of models to IFC files were resolved. (1) Frame
objects with a cardinal point other than 5, the middle-center of the section, were exported
to Architectural Coordination View and Structural Analysis View IFC 4 files with contradictory
information. Their cardinal point was properly specified in their associated
IfcMaterialProfileSetUsage object but their "Body" IfcShapeRepresentation attribute did not
reflect the position cardinal point. This incident did not affect export to IFC 2x3 files. All
versions of ETABS capable of exporting to IFC files were affected. (2) Beams were exported
with their "Axis" IfcShapeRepresentation attribute oriented parallel to their SAP2000 axis 2
instead of axis 1. This incident affected export to o Architectural Coordination View and
Structural Analysis View IFC 2x3 and IFC4 files. Again, all versions of ETABS capable of
exporting to IFC files were affected.

9135 An incident was resolved where the orientation of double-angle sections exported to IFC
was incorrectly rotated by 180 degrees.

* 9244 An incident was resolved where element mass in ETABS were not being correctly reflected in
the exported Perform3D model. The behavior has been changed so that element mass in an
ETABS model will be exported to Perform3D as equivalent masses lumped to the nodes
adjacent to the element.

* 9245 An incident was resolved where, for an ETABS model exported to Perform3D, the additional
mass and the mass from
specified load patterns in the mass source was not reflected in the exported Perform3D
model.

9246 An incident was resolved where, when an ETABS model with semi-rigid diaphragms was
exported to Perform3D, the exported Perform3D model would have diaphragm constraints
applied in place of the semi-rigid diaphragms, but no message was given. A warning message
has now been added, so the user may remove the constraint if they so wish. Note that the
use of the diaphragm constraints may cause the Perform3D model to behave differently
from the ETABS model, but they can also be beneficial for some Perform3D models, so the
user should choose the best option for their modeling purposes.

9247 An incident was resolved where Point, Frame, and Shell (Area)
element loads in an ETABS model were not included in models exported to Perform3D.
Results in Perform3D agreed with the model as imported.
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* Ticket Description
9306 An incident affecting the import of CIS/2 STEP files was resolved in which some STEP

"externally bound" entity definitions incorrectly combined sub-definitions and data defined
outside of these sub-definitions. When the user attempted to import such a file, ETABS
became unresponsive for a long while and eventually displayed an error message referring
the user to an error file in which the problematic entities were identified but the syntax
error itself was left unexplained and instead listed as a "bad allocation". When this occurred,
no model was created. All versions of ETABS capable of importing CIS/2 files were affected
by this incident. A related enhancement has been implemented. ETABS can now import
CIS/2 files in which the magnitudes of vectors are specified with the "LENGTH_MEASURE"
keyword, even though this keyword is unnecessary and normally omitted.

9390 An incident was resolved where ETABS layered-shell properties exported as Perform3D
"Shear Wall, Inelastic Section" or "General Wall, Inelastic Section" components would always
use the first rebar material defined in the model rather than a rebar material used in the
layered-shell definition. Now the Perform3D export (File menu > Export > Perform3D
Structure File) will use the rebar material from the first rebar layer in the layered-shell
property, when available. If there are no rebar layers, then it will use the first rebar material
defined in the model, same as the previous behavior.

Graphics
Incidents Resolved
* Ticket Description

8717 An incident was resolved where openings were not shown in elevation views when using
standard graphics mode. This did not affect DirectX graphics mode.

8863 An incident was resolved where the extruded shape for a variable frame section was not
shown correctly for the precast I-girder, Build-up I-section with plate, cold-formed Channel,
cold-formed Z-section, and cold-formed Hat section. This was only a display issue and no
results were affected. Note that when the shapes at the two ends of a non-prismatic
segment are of different types, only the rectangular bounding box will be shown for that
segment.

9193 An incident was resolved where surface load contours were not plotting correctly when in
the presence of vertical null areas. Now Vertical Null areas are excluded from surface
loading contour plots.

9300 An incident was resolved where reactions were shown on the undeformed shape when a
model was opened that had been displaying reactions when it was last closed. This issue
affected DirectX graphics mode only. No results were affected.

Installation and Licensing
Incidents Resolved
* Ticket Description

8991 An incident was resolved with cloud licensing where a client machine running with a lower
level license could unexpectedly pick up a higher level license when a second instance was
started or the license was refreshed, and a higher level license was available in the same
account. Typically this would only happen when the higher level license was in use by
another machine when the client initially started the program, and the higher level license
was returned from the other machine while the client machine was still using the program.

Loading
Incidents Resolved
* Ticket Description

8966 An incident was resolved for ASCE 7-02, ASCE 7-05, ASCE 7-10 and ASCE 7-16 auto wind load
cases where parapet pressure along the windward direction was applied uniformly using
total building height and did not capture the variation of wind pressure over the height of
the parapet. Results were slightly on the unconservative side since wind pressure was
computed using building height (h) instead of using parapet height (hp).
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* Ticket Description
9374 An incident was resolved where the load pattern(s) of type "Pattern Live - Auto" would not

get re-imported correctly when the model was exported and imported in text format or any
of the available database-table formats. The type for the affected load pattern(s) would be
set to "Other". Also, the multi-step static load case associated with the load pattern in
question would not get imported.

9439 An incident was resolved for the TSC-2018 auto-seismic load case where program-calculated
period should have been compared with 1.4*Ta instead of 1.0*Ta.

9450 An incident was resolved where a linear load case added to a model using the Application
Programming Interface (API) with applied seismic load pattern(s) and a mass source
different than the default mass source inadvertently calculated the corresponding seismic
loads based on the default mass source rather than the specified mass source. Analysis
results were affected only if the load case was run within the same session that it was
added. Saving and re-opening the model permanently fixed the issue.

Results Display and Output
Incidents Resolved
* Ticket Description

8710 An incident was resolved where a Performance Check (Define > Performance Checks) that
included interacting hinges could erroneously report a D/C ratio of 100. This issue only
occurred if a Demand Set in the Performance Check was defined using multiple steps of the
same nonlinear load case and the last step in the demand-set list was a step in which the
hinge was linear elastic. This issue only affected Interacting P-M2, P-M3, M2-M3 or P-M2-
M3 hinges. Fiber, parametric, and single-degree-of-freedom hinges were not affected. This
issue only affected performance-check results and did not affect other output.

8716 An incident was resolved for the concrete frame design report where the table "Beam
Capacities and Angles" presented in the design details for the Beam/Column Capacity Ratio
(BCCR) was showing the probable beam capacity for joint shear design instead of beam
nominal moment capacities for BCCR. This affected the ACI 318-19, ACI 318-14, ACI 318-11,
ACI 318-08, AS 3600-2009, AS 3600-2018, CSA A23.3-14, CSA A23.3-19, IS 456-2000, KBC
2009, KBC 2016, Mexican RCDF 2004, Mexican RCD 2017, TS 500-2000 and TS 500-
2000(R2018) design codes. This was only a reporting issue and design results were not
affected.

8878 An incident was resolved where an abnormal termination message was sometimes
produced when plotting responses for a multi-step static load case, linear or nonlinear. The
plot was not available following this message. This usually happened if the response
quantity being plotted was identical for all the steps (e.g., plotting Base Shear Z for an auto
pattern live load case where all slab panels in the model have same length and width).

8968 An incident was resolved where the Story Response plot (Display menu > Story Response
Plots) display types "Max Story Drifts" and "Diaph Drifts" did not plot the absolute maximum
drift values when the Output Type was set to MaxMin and the maximum drift occurred in
the negative global direction for multi-step load cases. This issue only affected the story
response plots and did not affect other response output such as the database tables.

8985 An incident was resolved where the Plot Functions feature (Display menu > Plot Functions)
did not show panel zone acceptance criteria values for the Acceptance Criteria D/C Ratios
plot-function type. This issue only affected the Plot Functions display and did not affect
other panel zone results such as the "Panel Zones - Element Status" database tables or
performance check results.

9167 An incident was resolved where the Performance Check D/C ratio display (Display
menu>Display Performance Check) for a frame hinge with a zero D/C ratio could be
incorrectly displayed as a non-zero D/C ratio. This issue only affected frame objects with
more than one hinge where the affected hinge with zero D/C ratio is preceded by a hinge
with a non-zero D/C ratio. When the issue occurred, the frame object would appear to have
two or more hinges with identical D/C ratios. The incorrectly displayed D/C ratio did not
exceed the maximum D/C ratio for any hinges in the frame object. This issue only affected
the Performance Check D/C ratio display and did not affect other Performance Check results
such as the Database Tables.
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* Ticket Description
9231 An incident was resolved where the scaling of reactions shown in printed output and PDF

files was inconsistent with that shown on the display in the graphical user interface.
9239 An incident was resolved where the table Modal Load Participation Ratios did not include

information for point springs that were generated using Link properties. This information is
expected for Ritz modal cases for all link objects, including those generated from springs.

9346 An incident was resolved for the CSA A23.3-14 shear wall design where wall-design
calculations were not available in the report.

9347 An incident was resolved where the calculation of the ASCE 41-13 NSP target displacement
for static pushover plots (Display menu>Static Pushover Curve) would sometimes fail to
produce a result for the case where the pushover curve has a slight stiffening effect in the
small-displacement range. The iterative procedure to determine the target displacement has
been improved to handle this case. However, curves that stiffen significantly are outside of
the scope of the specification, and may still fail to produce a target displacement, as
expected.

9351 An incident was resolved where the Soil Pressure contour (Display menu > Force/Stress
Diagrams > Soil Pressure) with the Max Abs option would not display the minimum value
when the minimum value was larger in magnitude than the maximum value. This issue only
affected the Soil Pressure contour display for multi-value or envelope type load cases or
combinations and has been resolved so that the Max Abs option displays the maximum or
minimum value of larger magnitude.

Section Designer
Incidents Resolved
* Ticket Description

8007 An incident was resolved where the elastic modulus and the concrete and rebar strengths
reported in the details of a concrete frame design that used a Section Designer section may
have been incorrectly reported if multiple concrete and rebar materials were present in the
model. The correct values were being used in the design, and this was only a reporting error
where the values for a default material were being shown.

9389 An incident was resolved where the text-file import of user-defined rebars in pier sections
was causing an import error, and the associated data was not imported as indicated in the
error message. Results agreed with the model as imported.

Structural Model
Incidents Resolved
* Ticket Description

8244 An incident was resolved where drawn section cut on screen results were different in some
cases when saved as quad section cuts. The saved quad section cut results were in error
when edge constraints were present. If edge constraints were cut they were being included
in the results even if the area element they belonged too were not to be included in the
results.

8859 An incident was resolved where if (1) a wall was assigned an auto-type property for drift
optimization and (2) analysis and design were run, and finally (3) the property was
overwritten through the API to a non-auto property, then the overwritten property would
not be used but would revert back to the optimized auto-type property when the analysis
was rerun.

8918 An incident was resolved where, for cracked section analysis with long-term effects, a user-
defined modulus of rupture for cracked deflections specified in the concrete Material
Property Data form (Define menu>Material Properties) was being multiplied by a 0.55 factor
for the following Slab Design codes: Indian IS 456-2000, BS 8110-1997, Hong Kong CP 2013,
and SG CP 65-1999. This resulted in larger than expected deflections reported for long-term
cracked section analysis using the affected Slab Design codes. This did not affect material
properties with the modulus of rupture for cracked deflections set to Program Default. This
issue affected ETABS v19.0.0 to v20.3.0.
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* Ticket Description
9067 An issue was resolved where joint offsets applied to shell objects using the joint-offset

option "Joint Offsets Specified Point-By-Point from Cardinal Point" and the Global
coordinate system in the "Shell Assignment - Insertion Point form" (Assign menu > Shell >
Insertion Point) would be applied incorrectly in the Local coordinate system. This issue only
affected shells where the option "Do not transform shell stiffness for offsets from centroid"
was de-selected by the user. Note that this option is selected by default, hence most models
were not affected. Additionally, a display issue was corrected where shell joint offsets
assigned in the Local coordinate system may not have been shown in the correct direction
on the display.

* 9210 An incident was resolved where the user-defined values for BRB Hardening hysteresis
parameters "Maximum Plastic Deformation at Full Hardening as a Ratio of Yield" and
"Accumulated Plastic Deformation at Full Hardening as a Ratio of Yield" were swapped in
Link objects using a MultiLinear Plastic type Link property with a BRB Hardening hysteresis
type. This issue only affected Link/Support properties, including point springs based on link
properties, and it affected both the tension and compression direction of the element. This
issue did not affect nonlinear material or hinge behavior.

9296 An issue was resolved where Parametric P-M2-M3 hinges created by assigning an auto hinge
to a frame object (Assign menu > Frame > Hinges) may have had invalid yield-surface or
force-deformation parameters. When this issue occurred, the model was unable to run due
to the invalid parameters.

* 9303 An incident was resolved where the user-defined interacting P-M3 concrete wall nonlinear
hinges with auto generation of interaction surface was using the default minimum
reinforcement instead of the specified reinforcement pattern. This error did not affect user
or auto defined fiber P-M3 wall hinges which were using the correct reinforcement.

9435 An incident was resolved where, in some rare cases, floor meshing near the column stiff
areas was incorrect. When this occurred, the error was obvious and results agreed with the
mesh as shown.

9471 An incident was resolved where the replicate-by-story operation was not working for curved
walls.

User Interface
Incidents Resolved
* Ticket Description

1439 An incident was resolved where the display of local axes for point springs could be confused
by the local axes that were displayed simultaneously for link properties, since multiple link
properties with different local axis can be assigned within the same point-spring property in
addition to directly assigned spring properties. The display of link local axes is now
suppressed when displaying point-spring local axes. No results were affected.

8707 An incident was resolved where column objects with insertion points other than at the
centroid were incorrectly displayed in plan views. This affected ETABS v20.0.0 to v20.3.0.
This was a graphical issue only and results were unaffected.

8858 An incident was resolved to address the following issues in reporting. (1.) The content
setting options "Show Selection Only", "Show Only if Used in Model", and "Show Numbers
Unformatted" were not being accounted for when generating the report. This has now been
fixed. The option "Show Only if Used in Model" applies only to applicable items under the
Define menu. (2.) The headings for "Table of Contents", "List of Tables", and "List of Figures"
were not being listed in the report explorer tree even when these sections were specified to
be included in the report. The generated report itself did include these sections as expected.

8953 An incident was resolved where, when assigning auto-hinges for concrete beam per Table
10-7 (Concrete Beams - Flexure) of ASCE 41-17, the text box to input user-specified V value
was sometimes not available on the form. This issue has now been fixed.

8993 An incident was resolved where, in the assignments tab of the right-click information form
for line objects, the text for the Self Weight Option under End Length offsets was not being
displayed correctly. A special character was being displayed instead for all available
parameter choices. The correct values could be seen in the database tables or model text
files (.$ET, .E2K). No results were affected.
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* Ticket Description
9190 An incident was resolved where an abnormal termination of the software could occur due to

repetitive clicking on the column headers on the Non-prismatic Frame Definition form.
9318 An incident was resolved where the labels for the frame hinges generated from auto-hinge

assignments were shown incorrectly for the following on the hinge result plot form: (1) Form
caption, (2) Plot title, and (3) List of hinges to select in the combo box.
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